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Version History 

Version Date Description 

1.0 February 19, 2019 First published version after full review. 
1.1 July 25, 2019 Formatting changes; updated screenshots 
1.2 December 23, 2021 Updated reference to correct Enrolment and Demographics 

document for information on maintaining student alerts. 
1.3 July 25, 2022 Added details to instructions in section 7.3.1 – To remove a 

snapshot from a student. 

 

Confidentiality 

This document contains information which is proprietary and confidential to Fujitsu Consulting (Canada) 
Inc. and Follett of Canada Inc. (submitted with their permission). The recipient of this document agrees to 
not use or reproduce it for any purpose other than its intended application which is to provide support and 
learning material for School Divisions implementing and using MySchoolSask. Without the prior consent of 
Fujitsu Consulting (Canada) Inc. and Follett of Canada Inc., the posting of a copy of the original document 
on a public website is prohibited. 
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1.0 Fundamentals  
 Logging In 

Individuals will receive their login name (username) and temporary password from their school 
or Division support staff. On initial log in, users will be required to change the temporary 
password before they can proceed. Passwords must meet the following criteria:  

• Minimum length is 8 
• At least one number 
• At least one capital and lowercase letter 
• At least one symbol that isn’t a letter or number 
• Cannot contain ‘password’, login name, first name, middle name, last name, date of 

birth, personal id, or only sequential letters or numbers. 

Enter the username and temporary password in the Login screen, and click Log On:  

 

Enter the following information in the Change Password pop-up that displays next: 

 
• Current Password – enter the assigned temporary password 
• New Password – enter the new user created password 
• Confirm New Password – enter the new user created password a second time 

 
Click OK. 

The Security Preferences Update pop-up window opens next. Setting security preferences will 
make it possible for a user to use the I forgot my password option that displays on the login 
screen. Enter the following information: 
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• Primary email - confirm or enter the user email that will be used for password recovery 
• Security question – select a question from the dropdown list 
• Security answer – enter the answer to the selected question 
• Confirm answer – enter the answer to the selected security question a second time 

 

• Click Submit 

Alternatively, select Later and the Security Preferences Update pop-up window will display 
again on the next login. 
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2.0 Managing User Preferences 
 Security 

The level of access each individual has in MySchoolSask, i.e. what data elements and menu 
items they can see, etc., is determined by the security role(s) assigned to their user account by 
their Division or school.  
 

 Settings Bar 

The settings bar is the first level of navigation in MySchoolSask. The options visible to the user 
are determined by the security access granted by the Division. Select School, for example, will 
only appear if the user has access to more than one school.  
All users see Set Preferences in the drop down menu under their name, and Log Off. 

 

 

 View Navigation 

The View that individuals see when they login, e.g. Division, School, Staff, etc., is the default 
view for the security role assigned to their user account. If a user has several roles assigned, 
the preferred View can be set as default under user preferences. Users with access to multiple 
views, as illustrated below, have a dropdown selection for view navigation. Selecting a different 
view from the dropdown changes the way the information is displayed, and scopes the 
information to the selected view. The example below shows the options typically available to a 
Division level user.  

 
 
To change views: 
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1. Click the drop down menu under the current View on the settings bar 
2. Select a view.  

 Select School 

If the user account has access to more than one school, the Select School option will appear on 
the settings bar menu.  
To select a school: 

1. Click Select School on the settings bar.  
2. In the pop-up window that displays, click the radio button beside the appropriate school.  
3. Click OK.  

 

 

 Set Preferences 

This option on the settings bar allows users to personalize MySchoolSask. The preferences that 
display in the pop up are specific based on the roles assigned to the user account and depend 
on the view the user is in, e.g. Division view is different from School view.  

2.2.3.1 General 

The settings under the General tab determine the default presentation of screens for the user – 
i.e. the default view and school as well other options of a general nature. See the table following 
the screenshot for a definition of each of these fields. 
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Field Description 

Default Locale Click this drop-down to select the language and date preferences when 
using MySchoolSask.  
This selection also affects the display of dates in MySchoolSask. select:  
Canada: Dates appear as date/month/year 
French (Canada): Dates appear as year/month/date 
US: Dates appear as month/date/year 
Note: A Default Locale must be set to prevent exception errors when saving 
preferences, including the Gradebook Preference Settings. 

Default View Click this drop-down to select the default view when logging on to 
MySchoolSask if the user has more than one view. 

Default School Click the  to select the default school when accessing the School view if 
the user has more than one school.  

Auto-save interval 
(minutes) 

Type the number of minutes to lapse before the system automatically saves 
the information entered on a detail page. The system displays a message to 
the right of the Save and Cancel buttons on detail pages, alerting the user 
of the time of the last auto-save, or why the auto-save failed. 

Disable User-defined 
Help 

This disables the user-defined help icon  for fields. This icon gives brief 
“tip” information on what is expected in that field. 
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Field Description 

Records per page This determines how many records display on the screen in a list before 
moving to the next page to see more. Set at the Enterprise level, the 
maximum records per page is 35.  

Show lower page 
controls 

Page controls display at the top of a page where the number of records in 
the list exceeds one page. To display the page controls at the bottom of all 
list pages, select this checkbox.  

 

Warn on save Check this box to display a warning when the user clicks Save on a list page 
after using the Modify List option. This is specific to the Modify List function 
and does not affect the user prompts to save when changing screens or 
tabs in the application.  

 

2.2.3.2 Home 

The Home top tab in Set Preferences will allow users to select page widgets that they want to 
see on the Landing Page. What is available here was determined by a provincial decision. 

  

2.2.3.3 Security 

The Security sub-top tab in Set Preferences records the user’s email address, security question 
and answer. These are required to enable the I forgot my password functionality on the login 
screen. User Passwords can be changed here by clicking the blue hyperlink Change then 
entering the current password and new password in the pop-up screen. 
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Field Description 

Primary email Type the primary email address. The system sends the password to this 
address when the 'I forgot my password' link on the logon page is used. 
Note: This is the address that displays in the From field when using 
the Send Email option. 

Alternate email If an alternate email address is entered, e.g. for a Google account, that 
address displays. This has no functionality in MySchoolSask. 

Security question Click this drop-down to select the security question to be used for the “I 
forgot my password” function. 

Security answer Type the answer for the security question. This will be case-sensitive.  

Confirm answer Type the security answer again. 

Password Click Change to change a user password. Password requirements can be 
viewed by clicking Click to view. 

 Log Off 

Use the Log Off button in the top right hand corner of the Settings Bar to exit MySchoolSask. 
This will properly terminate the session.  
 



 

Fundamentals v1.3 Page 13 

 Removing Browser Buttons (F11) 

Browser buttons for back, forward, and cancel should not be used to navigate the application. 
Navigating with the browser buttons can generate application errors or browser out of sync 
errors.  
F11 will hide the browser menu, removing the back, forward and cancel browser navigation. 
This is a toggle function; pressing F11 again will return the browser buttons.  
 

3.0 Navigation Tools & Selecting Records 
 Top Tabs and Side Tabs 

Top tabs represent functional areas of MySchoolSask. These are scoped to the user role so a 
user will only see what they have been given access to. The top tab that is highlighted indicates 
where the user is in the application.  
 
Side tabs provide access to additional details of the top tab functional area. 
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 Sub-side Tabs, Sub-top Tabs and Leaves 

Side tabs usually contain sub-side tabs, leaves and sub-top tabs. 

 
 
Sub-top tabs display at the top of a list, when a side tab is selected.  

 
 

 Page selector 

This navigation tool allows the user to select a range of records. The tool displays by default at 
the top of the list of data, and will display at the bottom of the list as well if the preference to 
Show lower page controls has been set.  
Use the drop-down arrow to select a page in the list, or the back and forth arrows at either side 
to move through the pages consecutively. 

 
In the drop down menu, the first record on each page is indicated. The number of records that 
display on each page is determined by the user preference setting Records per page. 
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 Record Navigation Bar 

The Record Navigation Bar can be used to change the record being viewed.  

 
For example, if the user is in the Student top tab > Details side tab, only one student is 
displayed. The user can: 

• Use the  in the record navigation bar to search for a new student without returning 
to the student list.  

• Use the forward and back arrows on the record navigation bar to move to the next 
consecutive record.  

• Use the first and last record buttons to move to the first record in the page selector or to 
the last record in the page selector. 

 Search Tool 

The search tool is present throughout the application to provide the ability to search the values 
in a field set or pop-up list. The user can enter the search criteria. The search is conducted on 
the first column of information in the field set, or the column of data that represents the primary 
sort. Clicking on a column header will sort the data on that column, and the search function will 
work on the selected column. The Search tool indicates which column the search is using with a 
Search on … prompt before text is entered into the field.  
Filters determine the students included in the search. For example, if the filter is set to Primary 
Active Students in the student list, the search will not return results for a student who is a 
secondary student. For details on Filters, see the Filters section. 
Results are returned with the closest match the system can make. The closest match record will 
be selected in the list.  

1. Enter the value to search for in the search field.  
2. Click the magnifying glass or the enter key to execute the search.  
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 Hyperlinks 

Hyperlinks are in blue lettering and an underline displays when the user hovers over them with a 
mouse. Clicking on a hyperlink will take the user to the details of that particular record. 

 
 

 Breadcrumbs 

When a user has selected a record and is viewing the details, a breadcrumb trail will appear at 
the top of the list to indicate the path used to arrive at that location. The breadcrumb presents 
with blue hyperlinks, clicking on any of the hyperlinks within the breadcrumb will return the user 
to that location.  
In the example below, the user is viewing student transcript record for a sample student in the 
School view.  
The user arrived at this screen by following this path: Student > Transcript > Details. The 
steps to follow the path are: 

• Click the Student top tab 
• Select the checkbox next to the student name in the Student List  
• Click the Transcript side tab 
• Click the Details leaf (or click into the blue hyperlink on the transcript record) 

The user can return to the Student Details by clicking on the Student Name in the breadcrumb 
trail, or return to the Student List by clicking on Student List in the breadcrumb trail. 
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 Checkboxes vs Radio Buttons 

There are many selection lists throughout MySchoolSask. If a list shows round radio buttons, it 
indicates that only one record can be selected. If a list shows square checkboxes, then multiple 
records can be selected.  

 Checkboxes 

A sample of the Checkboxes are found on the Student list: 

• More than one student can be selected at a time using the checkboxes in front of their 
names. Clicking the checkbox at the top of the list will select all of the records visible on 
the page. 

 
 

 Radio Buttons 

A radio button allows a user to select only one option. A sample of radio buttons is found in 
Student > Options menu > Snapshots:  
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• Only one snapshot can be selected because there are radio buttons in front of them.  

 

 

 Clearing Record Selections 

When multiple records have been selected in a list, a user may clear them using one of the 
following options: 

• Manually uncheck the box in front of a record. This will de-select an individual record.  

• Use the  icon at the top of the list of selected records. This will clear ALL selections. 
• Changing the filter to generate a new list. 
• Leaving the top tab to navigate to another area of the application. This is only true if the 

user is on the main list and has not performed an Options > Show Selected on the 
records.  

• Logging out of MySchoolSask. 

4.0 Icons and Alerts 
MySchoolSask will display a number of icons throughout the application to indicate additional 
information or alert information. Hovering over these icons will provide a tool tip that displays 
what type of information the icon contains. Clicking on the icon will generate additional 
information. These icons include: 

• Medical and health alerts: ,  

• Legal alerts:  
• Other alerts:  
• Quick Status for locating a student:  

• Student Services alerts:   

• Informational alerts:   

Information on maintaining student alerts is contained in the Enrolment and Demographics 
document.  

5.0 Menu Bar Buttons 
The menu bar buttons display just below the top tabs in MySchoolSask. The menu bar buttons 
are the same regardless of the top tab the user selects, and the list of items in the list display 
based on the screen.  
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The items displayed in the dropdowns of the menu will change, depending on the top tab and 
side tab the user has selected. 
 
The various tools in the menu bar are described in the following sections. 

 Options 

Use the Options menu to select, search for, filter, or perform actions on the records currently 
appearing on the list page. The Options menu contains selections appropriate for the current 
page. The Options list may include items with an arrow, indicating a fly out menu with additional 
options.  

 

 
 

 Reports 

The Reports button displays a list of reports available. This list is based on the top tab, side tab 
and leaf currently selected. For example: When in School > Student > List the Reports button 
provides a number of reports related to student demographics which can be printed for multiple 
students. When in School > Schedule > Master > Sections the Reports button provides a list of 
reports related to scheduling and course sections. The Reports list may include items with an 
arrow, indicating a fly out menu with additional reports. 
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The My Job Queue item in the Reports list will present a window that shows reports the user 
has run and the report status. So it is not necessary to wait for a report to finish once Run has 
been selected. The report can be retrieved later from My Job Queue. 

 
 

 Help 

The Help button provides several options for online instructions and tools that are core to the 
Follett product. The Help list may include items with an arrow, indicating a fly out menu with 
additional tools.  
 
Note: The tools in the Help menu are not customized for MySchoolSask, and may reference 
options or functions that are not available to Division and School users. 
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 On-line help 

On-line help opens in a new window and provides a variety of ways to search for information 
using the options on the left side of the screen.  
The On-line help functionality identifies where the user is when they select the help button and 
directs them to information related to that top and side tab. For example: If the user is in School 
> Student > Membership and selects the On-line Help option, they are directed to Working With 
Student Enrollment Information in the online guide.  
The information in the On-line help is not customized for MySchoolSask, and may reference 
options or functions that are not available. 

 Release Notes 

Release notes will provide information about the latest changes to the software product. This 
information refers to the Follett application as a whole; it is not customized for MySchoolSask. 
The release notes may reference options or functions that are not available.   

 User Guides 

User guides open up as documents with hyperlinks in the table of contents. These guides are 
not customized for MySchoolSask.   
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 Quick Reference Cards 

Quick reference cards are short, task-specific reference documents. These cards are not 
customized to MySchoolSask. 

 Videos & Training Tools 

This area of the Help menu provide Lesson Plans, Quick Reference Guides and Videos. 
Clicking on a category will display all of the options within that category. These tools are not 
customized for MySchoolSask and may reference options or functions that are not available.  
 

6.0 Queries 
A query is dynamic. A query performs a new search and displays current information each time 
the query is run. For example, the list of students assigned to a homeroom may be different 
today than it was yesterday because a new student enrolled and was assigned to the 
homeroom. 

 Create a Simple Query 

1. In the Options menu, select Query.  
2. In the New Query window, use the following table to select appropriate fields: 

 

Fields Descriptions 

Tables Select the table where the search information resides. The selected table determines the 
selections in the Fields area. 
For example, if the Student table is selected, fields in the student details appear. 

Fields At Fields, select the field to be included in the search criteria. 
Note: Fields within each reference table are listed from most commonly used to least 

commonly used. To change this order to alphabetical, click the Alpha Sort button  
Operator Select an appropriate operator. 

For example, if the search is for students with a specific year of graduation, select Year of 
graduation in the Fields box, and select the Equals operator. 

Value Enter the search value. In some cases, this may be a pick list or drop down menu. 

 
3. Click Add to add the criteria to the Search criteria box. To add other criteria, select 

the Table, Field, and Operator, and enter the Value, if appropriate. 
4. Click And or Or to determine if the students should meet the first criteria, the second 

criteria, or both to be included in the search. 
5. Confirm the correct search criteria are displayed in the Search criteria box. To delete the 

criteria from this search, highlight it in the Search criteria box and click Delete. 
6. In the Search based on field, use the drop-down to select which students should be 

included in the search.  
7. Click the Search button to execute the search.  
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Once a query has been executed, the records matching the search criteria will be displayed on 
the screen.  The upper right corner of the screen, above the list, will indicate that the records 
displayed are a custom selection. Use the  icon to return the list to all records or another 
selection.  

 

 Save a Query 

If a query will be used frequently, it can be saved for quick retrieval. 

1. Create a query using the instructions above.  
2. Click Save as… The Save as dialogue box displays.  

a. Name: Give the query a name that will make sense later. If saving as a filter, it is 
best to keep the name concise.  

b. Owner type: Click the drop-down to select one of the following: 
• User: to give an individual user access to the query. 
• School: to give users at a school access to the query. User must have 

access to the school view to use this option.  
• Division: to give all users in a Division access to the query. User must have 

access to the Division view to use this option. 
c. Owner Name: click the magnifying glass to change the owner of the query. The 

owner can edit a saved query.  
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d. Save as filter: Select this checkbox to have this query automatically appear on 
the  menu for all users who have access to it. If this checkbox is selected, the 
next three fields are accessible.  

e. Filter Owner type: Click the drop-down to select the owner type as appropriate. 
These options are defined the same as the Query Owner Type options. 

f. Filter Owner name: click the magnifying glass to change the owner of the query. 
The owner can edit a saved filter.  

g. Move to the top of my list: Checking this box will place the query at the top of 
the  menu. If a query is first on the filter menu, it becomes the default filter for 
that screen.  

3. Click Save. 

 

 Edit a Query 

Users must have the appropriate permissions to edit the query.  

1. In the Options menu, select Query.  
2. In the New Query pop-up window, click the Select button. A list will pop up with all the 

queries.  
3. Click the radio button beside the query to be edited.  
4. Click Edit.  
5. Adjust the Name and Owner fields, if necessary.  
6. Click Save. 
7. Ensure the query is still selected and click Use. 
8. Adjust search criteria as necessary.  
9. Click Save. 
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 Copy a Query 

Users can copy a query that contains elements they want and adjust it to suit their need. 

 

1. In the Options menu, select Query.  
2. In the New Query pop-up window, click the Select button. A list will pop up with all the 

queries.  
3. Click the radio button beside the query to be copied.  
4. Click Copy.  
5. Give the new query a Name and Owner type.  
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6. Click Save. 
7. Ensure the query is still selected and click Use. 
8. Adjust search criteria as necessary.  
9. Click Save. 

 Delete a Query 

If a query has become obsolete, it can be deleted  

1. In the Options menu, select Query.  
2. In the New Query pop-up window, click the Select button. A list of queries will pop up.  
3. Click the radio button beside the query to be deleted.  
4. Click Delete.  
5. Click Cancel to close the query list popup.  
6. Click Cancel to close the New Query window. 

 

7.0 Snapshots 
A snapshot is different from a filter. Where a filter is dynamic and always returns the latest data, 
a snapshot is a static list. It always displays the same records unless it is manually edited. Only 
the user who created the snapshot can add or remove students from it. 

 Creating and Deleting Snapshots 

 Create a Snapshot 

1. In the School view, click the Student top tab. Select the records to be included in the 
snapshot.  

2. If records have been manually selected in a large list, be sure to go to the 
Options menu and click Show Selected. Users can also use a filter or query to isolate 
the records for a snapshot. Snapshots will include any records that appear on the 
current list. 

3. In the Options menu, select Snapshots.  
4. In the pop-up window, click the New button. 

a. Name: Give the snapshot a name that represents the data in the snapshot. 
b. Owner: Who will see and use this snapshot? If the user has Division or school 

access, they have the ability to set this to all users with those views. If the user 
sees no other option, they are creating a user snapshot. 

c. Save as filter: If this is selected, the snapshot will appear in the filter menu 
under the  icon. 

d. Move to the top of my list: If this is selected the snapshot will appear as the first 
item in the filter menu and will become the default filter for that screen. 

5. In the Records to Include box, select one of the following: 
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a. Current List: includes records selected on the list page.  
b. Snapshot Combination: this will combine two existing snapshots and is only 

available if two or more snapshots have already been defined.  
This provides 3 options:  

i. Union: Any records that appear in the first snapshot selected or the 
second snapshot selected. For example, for a snapshot of students who 
are in grade 12 or have a program of study, select Union. 

ii. Intersection: Only records that appear in both the first and the 
second snapshots selected. For example, for a snapshot of students who 
are both in grade 12 and have a program of study, select Intersection. 

iii. Difference: Any record that displays in the first snapshot selected, but not 
in the second. For example, for a snapshot of students who are in grade 
12 but do not have a program of study, select Difference. 

6. Click Save.  

 

 Remove a Snapshot from the Filter Menu 

If a snapshot was saved as a filter in error, or is no longer needed as a filter, it can be removed 
from the filter menu.  

1. Click on the  icon and select Manage Filters. 
2. In the Manage Filters window, click on the snapshot so it is highlighted. 
3. Click the Delete button.  
4. Click Close.  

Note: Deleting the filter does not delete the snapshot behind it. The filter can be restored by 
creating a new filter and selecting the snapshot.  

 Delete a Snapshot 

If a snapshot has become obsolete, it can be deleted from the snapshot menu.  

1. In the Options menu, select Snapshots.  
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2. Select the snapshot to be deleted.  
3. Click Delete. Note that it warns the user that any filter associated with the snapshot will 

be deleted. 
4. Click OK.   

 

 Add a Snapshot to a Student 

Snapshots are static lists and will not update automatically when a new student meets the 
criteria the snapshot was based on.  

 To add a snapshot to a student: 

1. In the Student top tab, select the student to be included in the snapshot. 
2. Click the Snapshots side tab.  
3. In the Options menu, select Add. 
4. Select the snapshot from the list.  
5. Click OK. 

 

 Remove a Snapshot from a Student 

If a student no longer meets the criteria for the snapshot, a user may want to delete them from 
that snapshot.  

 To remove a snapshot from a student. 

1. From the Student top tab go to Options and select Snapshots. 
2. Select the snapshot to be modified. Click Use. The list of students in the snapshot will 

appear.  
3. Check the box beside the student to be removed from the snapshot. 
4. Click the Snapshots side tab.  
5. Select the Snapshot the student is to be removed from. 
6. In the Options menu, select Delete. 
7. Click OK. 

 

8.0 Menu Bar Tools 
The menu bar provides several tools for filtering, displaying, sorting and exporting data in 
MySchoolSask. The menu tools are the same regardless of the top tab the user has selected, 
with the exception of the quick letter function on the Student top tab. The options that display 
when using these tools will vary depending on the top tab and side tabs selected.   
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 Filters  

The Filter functionality is used to determine the records that display on a page. Selecting the 
Filter icon displays a list of filters currently available to the user. This list is based on the top tab, 
side tab and leaf currently selected, as well as the security role(s) assigned to the user.  
Filters are built from queries that provide a real time list of the students meeting the criteria 
defined in the query. For example: The Filter Homeroom = ? returns all the current students with 
the selected homeroom assigned. If a new student is assigned to the selected homeroom, they 
will immediately display in the filter list. 
Filters can be created at the Division, School or individual user level.  

System Filter Description 

All Active Students Primary Active, Active No Primary and Secondary Active Students 

Primary Active Students Primary students with a status of Active or Active No Primary. 

All Primary Students All Primary students for which this school is or was the last school of record, 
regardless of the current student Enrollment Status.  

All Secondary Students Students that have a secondary school association to this school, with a 
status of Active or Active No Primary. 

All Students All Primary students for which this school is or was the last school of record, 
regardless of the current student Enrollment Status, Active No Primary and 
Secondary students.  

Current Members All students with current admission dates, including students with secondary 
school associations that have a current start date. This filter does not 
include students with a future admission date, or students with future 
secondary school association start dates. 

Former Students Students who were withdrawn, but have a former school association to this 
school. If this association record is deleted, the student will no longer appear 
in the filter. 

Next Year Students Students with a Next School value field populated with the name of this 
school.  

The filters that appear in the list have been created at the system, enterprise or Division level. 

Click the  icon and select Manage Filters. In the Manage Filters pop-up window, users see 
the following in brackets beside the name of the filters: 

a. System: these filters are part of the core application. They can be hidden or 
moved up or down in the list, but cannot be modified. 

b. Enterprise: these filters have been created at the enterprise level and display for 
all Divisions and schools. They can be hidden or moved up or down in the list, 
but cannot be modified. 
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c. Division: these filters have been created at the Division level for the Division 
level views. They can be hidden or moved up or down in the list, but cannot be 
modified unless the user has access to the Division view. 

d. School: these filters have been created either by a school user, or by a Division 
user in the school view. They are visible to all users with access to the School 
view. These filters can only be modified or deleted by a school user or a Division 
user with school view access. 

e. User: these filters have been created by an individual user. They will only show 
in the list for the user who created them and therefore can only be modified or 
deleted by the user who created them.  

 

 Set a Default Filter 

A user can set the filter they use most often as the default for that screen by moving it to the top 
of the list. 

1. Click the  icon and select Manage Filters . . .  
2. In the Manage Filters pop-up window, click on the name of the filter to be moved. It will 

be highlighted.  

3. Click the  or  buttons to position the filter in the list. The filter at the very top 
of the list is the default filter when entering that screen. 

4. Several filters can be moved at once by using Shift + click and using the  or 

  buttons.  
5. Click Close. 

 Hide a Filter 

1. Click the  icon and select Manage Filters . . .  
2. In the Manage Filters pop-up window, click on the name of the filter to be hidden. It will 

be highlighted.  
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3. Click the  button. If the Show All box is checked, the filter will still appear 
here, but is now greyed out. This means the filter will no longer appear in the list when 

the  icon is clicked. The item can be restored at any time by clicking the  
button to put it back in the list.  If the Show All box is not checked, the filters which have 
been hidden will no longer be visible. This checkbox will need to be enabled in order to 
restore a hidden filter. 

4. Click Close. 

 Create a New Filter 

Filters are connected to queries and snapshots. Users can access those queries and create 
them as a filter by using the New button in the Manage Filters window. 

1. Click the  icon and select Manage Filters . . .  
2. In the Manage Filters pop-up window, click the  button. A list of available queries 

will appear.  
a. Filter Type: This allows a filter to be created from an existing query or snapshot. 

Changing this selection will change the list of options below.  
b. Owner: Who will see and use this filter? If the user has Division or school 

access, they will have the ability to set this filter for all users with those views. If 
the user sees no other selection, they are creating a User filter. 

c. Name: Give the filter a name that makes sense for its function.  
3. Click the radio button beside the query or snapshot in the list that the filter will be based 

on.  
4. Click OK. The filter will now appear in the Manage Filters window and in the list below 

the  icon for this screen. 
5. Click Close on the Manage Filters window. 
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 Edit a Filter 

A user can only edit a filter that exists at the level of their user role view. In other words, a 
Division user who has access to both Division and school views can edit a Division or School 
filter. A school user can edit a School filter because they have school view access. A user with 
staff view will only be able to edit their own User filters. 

1. Click the  icon and select Manage Filters . . .  

2. In the Manage Filters pop-up window, click the  button. 
3. In the pop-up window: 

a. Filter Type: This allows a filter to be changed from its current query or snapshot, 
to a new query or snapshot. Changing this selection will change the list of options 
below.  

b. Owner: Who will see and use this filter? If the user has Division or school 
access, they will have the ability to set this filter for all users with those views. If 
the user sees no other selection, they are creating a User filter. 

c. Name: Give the filter a name that makes sense for its function. 
4. Click OK. 
5. Click Close on the Manage Filters window. 

 

 Copy a Filter 

Because a filter is connected to a query or a snapshot, there are few reasons to copy a filter. A 
user may decide to copy a filter in order to rename it to something that is more meaningful.  

1. Click the  icon and select Manage Filters . . .  
2. In the Manage Filters pop-up window, click on the name of the filter to be copied. It will 

be highlighted. Click on the  button. 
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3. In the pop-up window: 
a. Name: Give the filter a name that makes sense for its function. 
b. Owner: Who will see and use this filter? If the user has Division or school 

access, they will have the ability to set this filter for all users with those views. If 
the user sees no other selection, they are creating a User filter. 

4. Click Save.  
5. Click Close on the Manage Filters window. 

If a filter has been copied, it may be practical to hide or delete the original to avoid confusion. 

 

 Delete a Filter 

A user can only delete a filter that exists at the level of their user role view. In other words, a 
Division user who has access to both Division and school views can delete a Division or School 
filter. A school user can delete a School filter because they have school view access. A user 
with staff view will only be able to delete their own User filters. 

1. Click the  icon and select Manage Filters . . .  
2. In the Manage Filters pop-up window, click on the name of the filter to be deleted. It will 

be highlighted.  

3. Click the  button.  
4. Click Close on the Manage Filters window. 

Deleting a filter does not delete the query behind it. If a filter is deleted in error, it can be 
restored by using the Add button.  

 Field Sets  

Field sets display information in a list. By selecting a different field set, the user is choosing to 
display different columns of information for the same records in the list. Field sets are useful for 
grouping commonly used sets of information and then extracting those into a spreadsheet for 
analysis or manipulation.  
The field sets that display in the list have been created at the Enterprise level or have been 
created by Division users who may have created them for their schools.  

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, users may see the following in brackets 

beside the name of the field sets: 
a. System: these field sets are part of the core application. They can be hidden or 

moved up or down in the list, but cannot be modified. 
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b. Enterprise: these field sets have been created at the enterprise level and display 
for all Divisions and schools. They can be hidden or moved up or down in the list, 
but cannot be modified. 

c. Division: these field sets have been created at the Division level for the Division 
level views. They can be hidden or moved up or down in the list, but cannot be 
modified unless the user has access to the Division view. 

d. School: these field sets have been created either by a school user, or been 
created by a Division user in the school view. They will be visible to all users who 
have access to the School view. These field sets can only be modified or deleted 
by a school user or a Division user with school view access. 

e. User: these field sets have been created by an individual user. 

 

 Move a Field set 

A user can set a field set they use the most as the default in that screen by moving it to the top 
of the list. 

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, click on the name of the field set to be moved. 

It will be highlighted.  

3. Click the   or  buttons to position the field set in the list. Any field set placed 
at the very top of the list will become the default field set when entering the screen. 

4. Several field sets can be moved at once by using Shift + click and using the   or 

 buttons.  
5. Click Close. 
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 Hide a Field Set 

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, click on the name of the field set to be hidden. 

It will be highlighted.  

3. Click the  button. If the Show All box is checked, the field set will still display 
here, but is now greyed out. This means the field set will no longer appear in the list 
when the  icon is clicked. The item can be restored at any time by clicking the 

 button to put it back in the list.  If the Show All box is not checked, the field 
sets which have been hidden will no longer be visible. This checkbox will need to be 
enabled in order to restore a hidden field set. 

4. Click Close. 

 Create a New Field Set 

1. Click the  icon and select Manage Field Sets . . .  

2. In the Manage Field Sets pop-up window, click the  button. 
3. In the pop-up window: 

a. Name: Give the field set a name that makes sense for its data set. 
b. Owner: Who will see and use this field set? If the user has Division or school 

access, they will have the ability to set this field set for all users with those views. 
If the user sees no other option, they are creating a User field set. 

c. In the Available Fields window, use the drop-down menu to select the table from 
containing the desired data fields.  These are listed in the order most frequently 

used. If the user is having trouble finding a field, use the  button to sort 
them into alphabetical order.  

d. Click on the desired field to select so it is highlighted in the list.  

e. Click the  button. This will move the field into the Selected Fields 
window.  
Note: Multiple fields from multiple tables can be selected for the same field set.  

4. Once all fields have been selected, click Save.  
5. Click Close on the Manage Field Sets window. The field set will now appear in the list 

for selection.  
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 Edit a Field set 

A user can only edit a field set that exists at the level of their user role view. In other words, a 
Division user who has access to both Division and school views can edit a Division or School 
field set. A school user can edit a School field set because they have school view access. A 
user that only has staff view will only be able to edit their own User field sets. 

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, click on the name of the field set to be edited. 

It will be highlighted. 

3. Click the  button. 
4. In the pop-up window: 

a. Name: Enter the new name for the field set, if appropriate. 
b. Owner: Who will see and use this field set? If the user has Division or school 

access, they will have the ability to set this field set for all users with those views. 
If the user sees no other selection, they are creating a User field set. 

5. In the Available Fields window, click the fields of information to add to the field set. Click 

the  button. Alternatively, in the Selected Fields window, click the fields of 

information to be removed from the field set. Click the  button. 
6. Click Save. 
7. Click Close on the Manage Field sets window. 
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 Copy a Field set 

A user may see a field set in the list that suits their needs, but would like to add or remove some 
information from it. If the user does not own the field set, a copy can be made and adjusted to 
suit the need.  

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, click on the name of the field set to be copied. 

It will be highlighted. 

3. Click the  button. 
4. In the pop-up window: 

a. Name: Give the field set a name that makes sense for its data set. 
b. Owner: Who will see and use this field set? If the user has Division or school 

access, they will have the ability to set this field set for all users with those views. 
If the user sees no other selection, they are creating a User field set. 

5. Click Save.  
6. Click Close on the Manage Field sets window. 

If a field set has been copied, the user may want to consider hiding or deleting the original to 
avoid confusion or duplication in the field set list. 
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 Delete a Field Set 

A user can only delete a field set that exists at the level of their user role view. In other words, a 
Division user who has access to both Division and school views can delete a Division or School 
field set. A school user can delete a School field set because they have school view access. A 
user that only has staff view will only be able to delete their own User field sets. 

1. Click the  icon and select Manage Field Sets . . .  
2. In the Manage Field Sets pop-up window, click on the name of the field set to be 

deleted. It will be highlighted.  

3. Click the  button.  
4. Click Close on the Manage Field Sets window.  

 Sorts  

There are different ways to sort data in a field set, which are defined below. The options for 
sorting data in a field set are: 

• Click the header of a column of data, a triangle displays pointing up or down in the 
column header to indicate the sort column and order. The field set sorts by the data in 
that column, opposite to its original sort order. Clicking the header again sorts the data 
back to its original order. This function can be used for multi-level sorts of up to three 
columns of data at a time. For example: clicking the Gender column in the Student top 
tab, then clicking the Pupil # column, then the Grade column, the grade would be the 
primary sort. Data displayed will be in order by Grade, then by Pupil #, then by Gender. 

 

• Use the  icon, which simply sorts the data in the field set by the list value chosen for 
the sort. The sort icon can also be used to set any sort back to the default.  

The field sets that appear in the list already have been created at the Enterprise level or by 
Division users who may have created field sets for their own schools.  



 

Fundamentals v1.3 Page 39 

1. Click the  icon and select Manage Sort Orders. . .  
2. In the Manage Sort Orders pop-up window, the following will appear in brackets beside 

the name of the field sets: 
a. System: these sort orders are part of the core application. They can be hidden or 

moved up or down in the list, but cannot be modified. 
b. Enterprise: these sort orders have been created at the enterprise level and 

appear for all Divisions and schools. They can be hidden or moved up or down in 
the list, but cannot be modified. 

c. Division: these sort orders have been created at the Division level for the 
Division level views. They can be hidden or moved up or down in the list, but 
cannot be modified unless the user has access to the Division view. 

d. School: these sort orders have been created either by a school user, or been 
created by a Division user in the school view. They will be visible to all users who 
have access to the School view. These sort orders can only be modified or 
deleted by a school user or a Division user with school view access. 

 

 Move a sort order 

A user can set the sort order they use the most as the default in that screen by moving it to the 
top of the list. Users can also create custom sorts.  

1. Click the  icon and select Manage Sort Orders . . .  
2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

moved. It will be highlighted.  

3. Click the  or  buttons to position the field set in the list. Any sort order 
placed at the very top of the list will become the default sort order when entering the 
screen. 

4. Several sort orders can be moved at once by using Shift + click and using the  or 

 buttons.  
5. Click Close. 
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 Hide a Sort Order 

1. Click the  icon and select Manage Sort orders . . .  
2. In the Manage Sort orders pop-up window, click on the name of the sort order to be 

hidden. It will be highlighted.  

3. Click the  button. If the Show All box is checked, the sort order will still appear 
here, but is now greyed out. This means the sort order will no longer appear in the list 

when the  icon is clicked. The item can be restored at any time by clicking the 

 button to put it back in the list.  If the Show All box is not checked, the sort 
orders which have been hidden will no longer be visible. This checkbox will need to be 
enabled in order to restore a hidden sort order. 

4. Click Close. 

 Create a New Sort Order 

1. Click the  icon and select Manage Sort Orders . . .  

2. In the Manage Sort Orders pop-up window, click the  button. 
3. In the pop-up window: 

a. Name: Give the sort a name that makes sense for its function. 
b. Owner: Who will see and use this sort? If the user has Division or school access, 

they will have the ability to set this sort for all users with those views. If the user 
sees no other selection, they are creating a User sort. 

c. In the Available Fields window, use the drop-down menu to select the table from 
which to sort fields.  These are listed in the order most frequently used. To help 

find a field, use the  button to sort them into alphabetical order.  

d. Click on the field to select it. It will be highlighted in the list. Click the   
button. This will move the field into the Selected Fields window.  
Note: Multiple fields from multiple tables can be selected or the same field set.  

4. Once all fields have been selected, click Save.  

5. Use the the  and  buttons to arrange the fields in the desired sort order. 

The   button will cause (desc) to appear beside the field highlighted when 
clicked. This means the data in that field will be sorted in reverse (descending) order 
when this new sort is applied to a field set. 

6. Click Close on the Manage Sort Orders window. The sort order will now display in the 
list for selection.  
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 Edit a Sort Order 

A user can only edit a sort order that exists at the level of their user role view. In other words, a 
Division user who has access to both Division and school views can edit a Division or School 
sort order. A school user can edit a School sort order because they have school view access. A 
user with staff view will only be able to edit their own User sort orders. 

1. Click the  icon and select Manage Sort Orders . . .  
2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

edited. It will be highlighted. 

3. Click the  button. 
4. In the pop-up window: 

a. Name: Enter the new name for the sort order, if appropriate. 
b. Owner: Who will see and use this sort order? If the user has Division or school 

access, they will have the ability to set this sort order for all users with those 
views. If the user sees no other selection, they are creating a User sort order. 

5. In the Available Fields window, click the fields of information to be added to the sort 

order. Click the  button. Alternatively, in the Selected Fields window, click the 

fields of information to be removed from the sort order. Click the  button. 
6. Click Save. 
7. Click Close on the Manage Sort Orders window. 
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 Copy a Sort Order 

A user may see a sort order in the list that suits their needs, but wants to add or remove some 
information from it. If the user does not own the sort order, a copy can be made and adjusted to 
suit the need.  

1. Click the  icon and select Manage Sort orders . . .  
2. In the Manage Sort orders pop-up window, click on the name of the sort order to be 

copied. It will be highlighted. 

3. Click the  button. 
4. In the pop-up window: 

a. Name: Give the sort order a name that makes sense for its data set. 
b. Owner: Who will see and use this sort order? If the user has Division or school 

access, they will have the ability to set this sort order for all users with those 
views. If the user sees no other selection, they are creating a User sort order. 

5. Click Save.  
6. Click Close on the Manage Sort Orders window. 

If a sort order has been copied, it may be practical to hide or delete the original to avoid 
confusion. 

 Delete a Sort order 

A user can only delete a sort order that exists at the level of their user role view. In other words, 
a Division user who has access to both Division and school views can delete a Division or 
School sort order. A school user can delete a School sort order because they have school view 
access. A user with staff view will only be able to delete their own User sort orders. 

1. Click the  icon and select Manage Sort Orders . . .  
2. In the Manage Sort Orders pop-up window, click on the name of the sort order to be 

deleted. It will be highlighted.  



 

Fundamentals v1.3 Page 43 

3. Click the  button.  
4. Click Close on the Manage Sort Orders window.  

 

 Quick Charts  

Charts provide an organized way to represent data visually. The Quick Chart feature enables 
the user to create bar, line, and pie charts from any standard list page. These charts can be 
saved for future use. Users with privileges to manage school and/or Division resources can 
create charts to share at both the Division and school levels.  

Click the  icon to access the following options:  

• Create Quick Chart: Brings up the Quick Chart Wizard, which allows the user to 
customize many different areas of the resulting chart. 

• Bar Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 
information required to create the bar chart. 

• Line Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 
information required to create the line chart. 

• Pie Chart: Brings up a streamlined Quick Chart screen, which requests only minimal 
information required to create the pie chart. 

 Create a Quick Chart: 

1. Click the  icon and select Create Quick Chart to open the Quick Chart wizard, or 
select Quick Chart from the Reports menu. The Create Quick Chart wizard displays: 
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2. Step 1: Source.  
a. Select New chart. 
b. Click Next.  

3. Step 2: Report Type 
a. Click the Report Type drop-down to select one of the following: 

i. Quick Chart—Bar 
ii. Quick Chart—Line 

iii. Quick Chart—Pie 
4. Click the Format drop-down to select the format for the chart. Select one of the 

following: 
a. Standard 
b. Enhanced  
 

 
 

5. Step 3: Field Selection.  

a. In the Categories (Horizontal Axis) box, click the  icon at Group by 
field and make a selection. The user can choose from the tables and fields that 
are related to the records in the current list. The Categories (Horizontal 
Axis) box, sometimes called the independent variable, sets the data to measure. 
If the choice is a Numeric, Date or Time field, additional options appear to 
organize the data further, which will be displayed on the chart.  
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b. For bar and line charts, a Series (Legend Entries) box is available. Click the  
icon at the Group by field and make a selection. Series groups appear in a 
legend to the right of the chart and provide a color-coded guide to data shown in 
the chart. 

Note: Bar and line charts do not require both a category and series to be selected. Charts that 
exclude a category will not have x-axis labels. Charts that exclude a series will not include a 
legend. 

6. The Interval drop-down menu for numeric has the following options: 
a. Chart each value separately: Each numeric value gets its own data point. 
b. Interval group: The Interval field groups the results according to the number 

entered in the Interval group size field. For example, to display the group Year 
of Graduation in the chart in pairs, a 2 would be entered in this field. The Interval 
group size displays. The value in this field sets the number of data points that 
get combined into a single category. 

c. Interval group summations. The Interval group size displays. The value in this 
field sets the number of data points that get combined into a single category. 

d. Total summation: Sums the values of the Group by field. 
7. If the list of data being charted contains trivial cases which should be excluded from the 

chart, the option Group trivial results as "Other” is provided. Select this checkbox if 
the users wants to group all data points of less than a certain percent together into a 
single point called Other. For example, if the user is only concerned with viewing the 
most common conduct codes, select this option and enter a value of 5% in the Less 



 

Fundamentals v1.3 Page 46 

than % field. This will group all codes that total less than 5% of the total data into a 
single Other group. 

Note: This option can only be used in the Categories or Series, not both.  

8. Click Next to continue the wizard and set chart header and footer display options. 
9. Click Finish to create the chart.  

Note: The Finish button can be clicked at any point in the wizard. New charts use the 
default format options if Finish is clicked at any point before the final step in the wizard.  

 Use a Saved Quick Chart 

1. Click the  icon and select Create Quick Chart to open the Quick Chart wizard, or 
select Quick Chart from the Reports menu. The Create Quick Chart wizard displays: 

 

 

2. Step 1: Source. Click Saved report. A table of saved Quick Charts displays in the dialog 
box. Select the Quick Chart to be viewed or edited. 

3. Click Next to continue editing, or click Finish to show the chart. 

 

 Quick Print  

Users can generate a Quick Print using the  icon in the menu bar on any list page.  
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 To generate a Quick Print using the Quick Print icon: 

1. Go to the list page containing the type of data to be reported on. 
2. Select the records to be included in the report. 
3. If individual records have been manually selected from a large list, be sure to go to the 

Options menu and click Show Selected. Users can also use a filter or query to isolate 
the records to report on. Quick Prints include any records that appear on the current list. 

4. Click the Quick Print icon  in the menu bar.  

 
5. Select one of the format options. 

a. Web Page (HTML): to view the information in an HTML file. 
b. CSV: to view the information in a text file that separates each field with a comma. 

If saved, the file will have a .CSV extension 
c. TXT: to view the information in a text file that separates each field with a comma. 

If saved, the file will have a .TXT extension. 
Note: The two comma-separated values formats (CSV and TXT) create identical 
files; the only difference is the file extension. Some Web browsers only handle 
one extension properly. 

d. Microsoft Word (DOC): to view the information in a Word document. 

Note: Different browsers handle quick prints in different ways. Users may need to change 
browser settings to allow downloads, or use shortcut keys such as Ctrl + S to save the data 
prior to opening it. 

 Maximize  & Minimize  

Users can click on these icons to hide top tabs to allow more records per page to be 
visible or to return top tabs to their view. 
 

9.0 Quick Reports 
Quick Reports provide an opportunity for a user to create a customized report that contains 
specific data elements from one or more tables. If the report is something that would be run 
multiple times or by multiple users, a Quick Report can be created and saved, then selected 
from the list as needed.  
Quick reports can be created in different areas of the application with elements that are relevant 
to the chosen area (top tab and side tab) of the application. 
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 Create a Quick Report 

Quick Reports can be created with different presentations. The following sample reports use the 
same fields, but are present differently:  

• Simple: A list of records and the selected fields 

 

• Detail: A page for each record with selected fields aligned vertically 

 

• Group: A list of records and the selected report fields, grouped by a selected field 
(School Name in the sample)  
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• Summary: Cumulative values based on the records selected (School Name in the sample) 

 
In the example below, the simple Quick Report will provide a school with a report indicating 
which students have Release of Information indicators, and is created from the Student top tab.  

1. In the School view, click the Student top tab 
2. Click the Quick Reports Icon and Select Create Quick Report or, Click the Reports 

menu item and select Quick Report 

 
3. In Step 1 of the Wizard, select New Report. Click Next. 
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4. In Step 2 of the wizard, select Simple. Click Next. 

 
5. In Step 3 of the wizard, the current field set will display as the selected fields  
6. Select the desired fields and click the Add >> button to move it to the Selected Fields 

box.  
a. The drop-down menu Under Available Fields can be changed from the Student 

table to a different table to combine data elements from other areas of the 
application. 

b. The Sort button  will sort the available fields for the selected table in 
alphabetical order, making it easier to locate specific fields.  
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7. In the Selected Fields box, click on any fields not needed and click the Remove button.  

 
 

8. Click Next. 
9. In step 4 of the wizard, select the field(s) to sort by in the Available Fields list and use 

the Add button to move them to the Selected Fields box.  The primary sort will be the 
first field in the Selected Fields box; the secondary sort will be the second field, etc.  
 

 
 

10. Click Next. 
11. Step 5 of the wizard is optional. Use these functions to create counts, and page breaks if 

desired. 
12. Click Next. 
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13. In Step 6 of the wizard: 
a. Report Title: Enter a title for this report.   
b. Print date: If selected, the date the report was generated will appear on the 

report.  
c. Body > Format: Select the format for the report. 
d. Exclude byte order mark: Can be checked if the report will be loaded to a 

system requiring limitations in text. Hover over the question mark symbol for 
details.  

e. Body > Font Face: Select the font for the report.  
f. Body > Font Size: Select the font size for the report.  
g. Body > Grid lines: Select whether the report should have grid lines for 

horizontal, vertical, or both, or none. 
h. Shade alternate lines: If selected, the data will appear with grey shading on 

alternate lines.  

 
 

14. Click Next. 
15. Step 7 of the wizard is optional. It allows the user to rename the fields that will appear on 

the report. To adjust the name of a field, select it from the Field drop-down. In the Title 
field, enter a name. Note that the field is only being re-named for the report – not for the 
application. Font, Size, Bold, Italic and Underline can be selected to tailor the field name 
in the report.  
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16. Click Next. 
17. In Step 8 of the wizard, the report may be saved for future use. To save this quick report, 

click the Save As radio button.  
a. Name: Enter a name for the saved report. 
b. Owner Type: Select from the drop down list.  

i.  Division: Report will be available for Division users 
ii. School: Report will be available for School users in the selected school 
iii. User: Report will be available for only the user creating the report 

c. School: Select the school (if applicable)  

  
 

18. Click Finish. 

 Run a Saved Quick Report 

If a report was saved, it is now available in Quick Reports based on the Owner type selected. 
Quick Reports provide an opportunity for a user to create a customized report that contains 
specific data elements. For the example below, this is done from the Student top tab, but quick 
reports can be created in different areas of the application with elements that are relevant to the 
chosen area of the application.  

1. In the School view, click the Student top tab 
2. Click the Quick Reports Icon (printer) and Select Create Quick Report OR Click the 

Reports menu and select Quick Report 

 
3. In Step 1 of the Wizard, select Saved report. 
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4. The available saved reports will display, select the report. 
5. Click Finish to run the report as is or click Next to make changes to the report an 

proceed through the steps of the wizard as outlined in Creating a Quick Report. 
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